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PageMaker Q&A

Your questions answered: solutions, tips, and techniques

Here are the answers to some questions recently asked about Adobe products, assembled by mem-

bers of Adobe’s technical-support group and the staff of Adobe Magazine.

We’re always looking for good tips. Send us your favorite, and if we print it we’ll send you an

Adobe Magazine T-shirt. E-mail your tips to magazine.editor@adobe.com, or send them to Editor,

Adobe Magazine, 411 First Avenue South, Seattle, WA 98104-2871. Please include your name and

phone number in case we need more information. Although Adobe Magazine is happy to consider

technical questions for inclusion in our Q&A sections, we generally aren’t able to respond person-

ally to such queries. Please contact Adobe technical support if you need help with one of the prod-

ucts covered here—phone-support options are listed on pages 118–19 of this issue.
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Q

 PC
Q I’ve got some text that has a color applied to it, and

when I print it to a black-and-white printer, the text

comes out solid black instead of the shade of gray that

I’m expecting. What can I do?

A First, you should click on the “Color” button in  the “Print

Document” dialog box to check whether you’ve got “Print

colors in black” selected. If you do, deselect that option, and

you’re probably home free.

If not, chances are that your problem has to do with print-

ing TrueType fonts to a PCL printer. When PageMaker prints

colored TrueType fonts to a black-and-white PCL printer, the

characters are rasterized (converted to a series of dots your

printer understands) by the Windows Graphical Device In-

terface (GDI), a Windows subsystem that controls many

printing and display functions. The GDI rasterizes colored

text as either black or white instead of approximating the

color saturation using a shade of gray. Fortunately, it’s pretty

easy to get around this, using one of the following methods.

◗ Rotate or skew the text block to force the text to print

correctly—even .01 degree will do it, and it won’t be no-

ticeable. Black-and-white PCL printers use a different set

of GDI commands to process transformed text than they

do for regularly set text.

◗ Reformat the text using a PostScript Type 1 font (installed

via Adobe Type Manager). Type 1 fonts are generally by-

passed by the GDI, so they won’t experience the symp-

toms commonly seen with TrueType fonts.

◗ Print to a PostScript or color PCL printer, if one’s available.
 PC/Mac
Q When I type text into a publication, the individual

characters overlap one another instead of wrapping to

the next line on screen. Sometimes I also get this effect

when I print my documents. What is happening, and

how do I fix it?

A A few different scenarios can cause this behavior in

PageMaker. Generally, text refuses to wrap for one of two

reasons. There may be no space characters for PageMaker to

use to break the line of text, or the words may be very long

(fundamentally the same problem). Or an internal or exter-

nal factor (for example, type-specifications settings or op-

tions chosen in a type manager, respectively) is interfering

with the process of breaking the line. Check the following

things, listed from most common and easily overlooked to

more arcane system-related matters, and see if one of them

doesn’t solve the problem for you.

◗ Make sure you’ve used the space bar on your keyboard to

place breaking space characters on each line.

◗ Make sure the “Line End” option is set to “Break” in the

“Type Specifications” dialog box. When the “Line End”

option is set to “No Break,” the text cannot break or wrap;

characters will overlap or stack on top of each other

rather than wrap to the next line when the end of the line

is reached.

◗ In a copy of the publication, select the pointer tool and

perform a global recompose (Ctrl + “Hyphenation…” on a

PC, Option + “Hyphenation…” on a Mac) to ensure that

the text is composed with correct font metrics. A global
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◗

PageMaker
recompose is not to be confused with a

diagnostic recompose, which is Ctrl +

Shift + “Hyphenation…” on a PC, Option

+ Shift + “Hyphenation…” on a Mac. A di-

agnostic recompose, in addition to re-

composing text, also checks all links and

external connections; that’s not neces-

sary in this case.

◗ Assign a different typeface to the text

that won’t break. If it then breaks, it may

indicate that the original font is dam-

aged, either as applied to a particular

piece of text or at a system level. Delete

the nonbreaking text, do a “Save As,” and

then recompose your file, or, for possible

system-level font damage, remove and

reinstall the typeface.

◗ Using Adobe Type Manager (ATM)
3.0.1 or earlier with PageMaker 6.0 in

Windows 95 may cause text to display or print with incor-

rect character spacing. If you have this configuration, re-

move your copy of ATM and install ATM 3.0.2, which is in-

cluded on the PageMaker 6.0 Deluxe CD-ROM. (For

instructions on deinstalling ATM 3.0 or earlier, send an E-

mail to techdocs@adobe.com and request document

341402, or obtain FaxYI document 341402.) Versions of

ATM prior to 3.0.2 are not compatible with Windows 95.

To check which version of ATM you have installed, click

the Windows 95 “Start” button, then navigate to the ATM

Control Panel (from the Main submenu of the Programs

menu). You should see the version number in the upper-

left corner of the “ATM Control Panel” window.

If you’re printing from PageMaker 5.0x and Windows 3.1x

to a Hewlett-Packard LaserJet III printer using the Univer-

sal printer driver 3.1.2 and mini-driver 2.0, select the text,

then choose “Paragraph…” from the Type menu and click

the “Spacing…” button. In the “Paragraph Spacing At-

tributes” dialog box, deselect the “Pair kerning” check

box, or enter a pair-kerning value for “Auto above” that’s

greater than the point size of the text. This will effectively

disable pair kerning for the selected text.
  Tip  PC/Mac
 PC/Mac
Q When I’m importing a graphic, I often receive the

message “The graphic in the document would occupy

[size] Kbytes in the publication. Include complete copy

in the publication anyway?” I usually just click “Yes,”

but I’m never sure if this is the right choice. What differ-

ence does it make?

A Clicking “Yes” could make a big difference if you plan to

import many large graphics into a PageMaker publication;

as is often the case, you have to consider the trade-offs in-

herent in your choices. The question you describe above re-

ally asks you: “Do you want to make your PageMaker publi-

cation much larger, but not have to keep track of your origi-

nal graphic files, or would you prefer to keep your publica-

tion small but have to monitor the graphic files?” Links are

at the core of this discussion, so we’ll review them here.

Whenever you import something into PageMaker using

the “Place…” command, it creates a link to the original file,

regardless of what kind or size of text document or graphic

you are importing. This link consists of a path that tells

PageMaker where the file is located. To see the path, choose

“Links…” from the File menu, click on one of the links, and

then click the “Info…” button. Look at the “Location” infor-

mation on the right side of the window. That’s the path.

Links are created for two basic reasons. One is that links

allow you to dynamically update information that has been

placed into your publication. For instance, say you place a

graphic into PageMaker on Tuesday, and then on Wednes-

day you open up that graphic in Photoshop, make some

changes, and save it. The next time you open the PageMaker

publication containing that graphic, PageMaker will notice

that the graphic has been modified since the publication

was last opened. You can set PageMaker to automatically

update a graphic whenever changes are made to it so that

you don’t have to re-import the modified graphic into

PageMaker. See “Managing linked text and graphics,” which

starts on page 304 of the Adobe PageMaker User Guide.

The second reason that PageMaker creates a link will ad-

dress your original question. In order to help you maintain

your publications at a manageable size, PageMaker provides

you the option of not including the graphic as part of the

publication. Every graphic that you store in the publication

will add its own size to the total publication size. So if you

have a graphic that is 500 K and you add it to a 150-K publi-

cation by clicking “Yes” to the question above, your
micro t ip

Got a problem you can’t solve?

Check out Adobe’s Technical

Solutions database on the World-

Wide Web. This database contains

over 4,000 records of information

and solutions to common and some

not-so-common issues you might

encounter when you’re using Adobe

products. To reach it, point your

Web browser to http://www.adobe.

com/supportservice/custsupport/

tssearchdb.html.
Get out your magnifying glass
It’s hard to imagine, but we’ve been told by many customers that sometimes 6-

point type just isn’t small enough. (We picture this category of users as including

lawyers and the publishers of Lilliputian newspapers.)

Here’s a way to shrink text further and keep it editable. Create and lay out your

type at 6 points. Then choose “Select All” from the Edit menu and “Type Specs…”

from the Type menu. Choose “Superscript”  from the “Position” drop-down list,

then click “Options….” In the “Type Options” dialog box, change the “Super/sub-

script size” setting to a percentage that fits your needs, and set the “Superscript

position” to 0 percent to keep the text on the baseline.

—Submitted by Christopher Drum of Raleigh, N.C.
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total publication size would then become approximately

650 K. If you click “No” to the question above, the publica-

tion will include only a low-resolution bitmap or screen im-

age as a placeholder, so the total publication size would in-

crease only slightly—say, to approximately 200 K.

Smaller publications take up less RAM and less of your

computer’s resources, which adds up to better performance

while you’re working in that publication. Smaller publica-

tions also have less chance—even on a purely statistical ba-

sis—of becoming damaged or having read/write problems

when being opened, closed, or moved, especially in a net-

work environment.

Given this, the answer to your question seems obvious,

right? Well, not exactly. You still have to weigh the advan-

tages and disadvantages.

 You’ve already seen some of the benefits of saying

“No”—of not including a copy of graphics in your publica-

tion. The disadvantage is that PageMaker becomes com-

pletely dependent on that link to the original image. If that

link is ever broken, the image may not print properly. (Links

are broken when the original image is no longer at the loca-
tember/October  1996
tion specified in the “Links” dialog box, because it has been

moved, renamed, or—heaven forbid— deleted.) The good

news is that PageMaker will warn of this danger automati-

cally when you try to print a document containing broken

links critical for printing, and will give you a choice of print-

ing anyway or canceling the job. As a result, when you store

graphics outside of your publication, you must manage

your links carefully; moving or renaming files will cost you in

time down the line if nothing else (although PageMaker has

thoughtfully included an “All linked files” option in the

“Save As” dialog box for just those occasions when you

need to gather up your files for remote printing).

One of the primary advantages of clicking “Yes” to store

images in the publication is the relative freedom of not hav-

ing to manage your links (unless the graphics change). Be-

cause the image is included as part of the publication,

PageMaker no longer depends on the link to print the im-

age. The original can be moved, renamed, or deleted, and, in

most cases, PageMaker will still be able to print the image

properly. If your graphics seldom change, all the better.

In general, if you are working with a large number of

graphics (say, around 20 or more per publication), or graph-

ics larger than 1 MB, you should avoid including a copy of

the graphics in the publication. If you have only a few

graphics in your publication, and they’re fairly small, they

won’t significantly increase the size of your publication. Un-

der these circumstances, it might be to your advantage to

embed the graphics. Another time to consider linking

graphics is when including them would cause your file to be

very large. “Very large” is a matter of personal preference

and experience, perhaps influenced by how often you have

to move your files to different locations. As a very general

starting point, we suggest that 5 MB is a suitable threshold

over which to consider linking.

Here are a few ways that PageMaker can help you cus-

tomize the way that you handle storing graphics on a publi-

cation-specific or application-wide basis.

◗ Adjust the size threshold for automatically storing graph-

ics (by default, 256 K). Select “Preferences…” from the

File menu, then click “More…” and change the value in

the “Alert when storing graphics over” box. To make this

the default setting for any document you subsequently

create in PageMaker, make the change without any

PageMaker  documents open.

◗ Tell PageMaker whether or not you’d like to automatically

store everything in the publication by default. Choose

“Link Options…” from the Element menu, making sure

no element is selected. Leave “Store copy in publication”

checked to automatically include copies of all graphics

(remembering that PageMaker will still alert you when

placing graphics larger than the size you designated un-

der “Preferences”) or unchecked to keep the full graphics

outside the publication. By default, this option is checked

for all new publications you create.

◗ In PageMaker 6.01, use the new Global Link Options Plug-

in (from the Utilities menu) to further customize your

graphics storage options on a page-by-page basis. The

Global Link Options Plug-in also lets you change from in-
PageMaker  Tip  Mac only

Avoid last-minute printing worries
When you’re planning a long-awaited vacation, you may tend to ignore, until the

last minute, the mundane process of packing. It’s not that different when you’re

knee-deep in an important design job—consumed with the creative process,

the last thing you’re thinking about is what you need to bring with you to get

it printed, and how you’re going to get it there. It’s wise to have a checklist

when you’re preoccupied and packing, and it’s wise to have the CheckList

utility when you’re packing up a big job for the service bureau.

CheckList 2.6 reports on font usage, printer settings, style sheets, and

linked graphic files in PageMaker 6.0x publications. It also analyzes font and

print-setting information for EPS files and PostScript print-to-disk files. The

analysis can then be printed in a report form, or pasted to another applica-

tion. In short, CheckList provides you with an easy way of gathering informa-

tion about the contents of your publications before taking them to be

printed at a remote location, such as a service bureau.

CheckList has an integrated “Packager,” which can compress publications

and then split the compressed file across several disks. The Packager can also

include necessary graphics, screen and printer fonts, tracking values, and

prep files in the compressed package. The resulting compressed file is self-ex-

panding, so CheckList needn’t be present to unpack the information.

Even if you don’t ever print your documents remotely, CheckList can still be

useful to you. CheckList can download EPS and PostScript files, with the option

to download all necessary fonts first. The downloader can query the printer for

installed fonts before the download, so only the missing fonts are downloaded.

In addition, you can use CheckList to help you manage your fonts. CheckList will

automatically generate a report indicating damaged, duplicate, or conflicting

fonts, or the presence of competing font technologies (for example, TrueType

and PostScript versions of the same typeface).

And it’s free.

CheckList 2.6 comes with PageMaker 6.01 for the Macintosh. You can find it in

the “Utilities” folder, which is inside the “Adobe PageMaker 6.01” folder.
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ternal to external (or vice versa) at

any time. If you switch from inter-

nal storage to linking, remember

to then use “Save As…” so

PageMaker can purge the stored

graphics from the publication.

 PC/Mac
Q In the March/April issue of your magazine, you had a question

about a Build Booklet problem in PageMaker where you receive the

error “Invalid state for requested operation.” I followed the instruc-

tions, but that hasn’t solved my problem. What else could it be?

A If the problem isn’t solved by checking for overset text or locked

items—common reasons for the error you mention—then the publica-

tion may be too large, or it may contain at least one problematic graphic

or text block on one of the pages. The best method of systematically

troubleshooting this type of situation is to break the publication down

into progressively smaller and smaller pieces until the problem element

has been isolated. Here’s a recipe for solving the thorniest of Build Book-

let problems.

Step 1: Divide and conquer. First, divide the problem document into

two equal halves. The easiest method of doing this is to make two copies

(in Explorer, File Manager, or Finder) and remove half the pages from one

copy, then the other. Run the Build Booklet Plug-in separately on each of

the two new publications. If both halves work independently, it’s likely

that the size of the document was causing the error message. (This

doesn’t mean that there is a specific size limit when using Build Booklet;

it means that Build Booklet makes interim copies of the file as it creates

the new spread, and it needs two to three times the file’s size in free disk

space to function properly.) If one or both of the newly divided test cop-

ies of the publication fail, then proceed to the next step.

Step 2: Find the problem page(s). Divide the test publication(s) that

failed into halves again, and run Build Booklet on each. Discard any file

that runs Build Booklet without error; repeat the step with the files that

fail. Do this until you have narrowed the problem down to the individual

pages that don’t work with Build Booklet.

Step 3: Isolate the problem element(s). Once you’ve found the prob-

lem page(s), look at the pages for common graphics, styles, or any other

elements. Try to “jog” elements you suspect—for instance, change fonts,

or relink, reimport, or recreate elements. Or just start dropping objects

from the page(s), one by one, and running Build Booklet between each

step (after having made a backup copy, of course). When Build Booklet

runs on all pages, go to the backup and address problems with the de-

leted object(s). If the element is a graphic, try re-placing it into the docu-

ment or, if necessary, re-export the graphic from the application that cre-

ated it first. If the problem is with a PageMaker-created object, such as

text or a shape, try re-creating the object.

Depending upon the size of the document, this can be an arduous

process. However, it’s relatively foolproof and practically guarantees that

once you’ve reached the end, you’ll have an answer to your problem.

Q  When I select “Create Adobe PDF…” in PageMaker, the “Distill

now” option is grayed out in the “Create Adobe PDF” dialog box.

Why is this happening?

A Most likely because PageMaker can’t find Acrobat Distiller. Distiller is

the engine that converts PageMaker’s PostScript files into PDF form for



Q&APageMaker

T

t

g

w

it

L

it
viewing in Acrobat Reader or Exchange. For

PageMaker to automatically convert the docu-

ment into PDF form, it has to know where the

Acrobat Distiller application resides on your

hard disk. If PageMaker can’t find Distiller for

some reason, the “Distill now” option will be

unavailable. Resolving the problem is a matter

of getting PageMaker to locate the Distiller ap-

plication. In the short term, don’t worry—you

can write your PostScript file to disk now, if you

like, and distill later.

There are a few reasons

why PageMaker may not be

able to find Distiller. Before

you try anything else, make

sure that Adobe Acrobat Dis-

tiller version 2.0 or later has

been installed. This program

is included with PageMaker 6.0x, or you may

have installed it separately. If you can’t locate

the Distiller program on your hard disk, install it

from your PageMaker CD or disk set and then

make sure it launches. If the “Distill now” op-

tion is still dimmed at this point, browse

through the following list.

If you use PageMaker 6.x with Windows 3.1

or Windows 95:

◗ Quit PageMaker, then delete the files

“CreatPDF.ini” and “CreatPDF.prf” in the

PM6\RSRC\USENGLSH\PLUGINS directory.

◗ Hold down the Shift key while choosing

“Create Adobe PDF…” from the File menu,

then go to the Distiller application when
prompted (ACRODIST.EXE or ADISTPE.EXE).

The path information pointing to the Distiller

application is stored in the “CreatPDF.ini” file.

The directions listed above are two ways to

force PageMaker to relocate the application

and re-create the correct path.

If you use PageMaker 6.x on a Macintosh:

◗ Quit PageMaker, then delete or rename the

“Create Adobe PDF.prf” file in the “Plugins”

folder in the “RSRC” folder in the “Adobe

PageMaker 6.0” folder.

◗ Rebuild the desktop file by holding down

the Command and Option keys while re-

starting. Keep holding down the keys until

you receive the message “Are you sure you

want to rebuild the desktop file on the disk

[diskname]?” Click “OK.” If you are using Sys-

tem 7.5 or later, use the Extensions Manager

to turn off all Extensions except Macintosh

Easy Open before you rebuild the desktop. A

corrupt or out-of-date desktop may not cor-

rectly report or locate installed applications,

and if your Macintosh can’t find it, Page-

Maker won’t be able to find it.

◗ Before you launch the Create Adobe PDF

Plug-in, move the Acrobat Distiller applica-

tion file to the desktop. After the Create

Adobe PDF Plug-in has launched, you can

move the Acrobat Distiller application file

back to its original location, if desired. Mov-

ing Distiller to the desktop may bypass a

damaged folder or system that can’t prop-

erly report its location. ◗
PageMaker  Tip  PC/Mac

Wrap it to go
Use PageMaker’s text wrap feature to create reusable wraps for text

effects. You can create different shapes or lines either in PageMaker or

in a graphics program, apply text wrap to them, and then adjust the

boundary so that it conforms to the contour of the object. Click with

the pointer tool on the dotted boundary line that defines a text wrap

to create individual points that serve as anchors. Using an object as a

kind of template, you can then drag these anchor points into position

along the edge of the form or object. (For more detailed instructions on

text wrap, see page 178 of the Adobe PageMaker User Guide.)

After you’re done, apply the color “Paper” to the graphic or “None” to

its line style to make it disappear, leaving just the dotted boundary line

that you can use to shape text in your layout. Send the graphic to the

back to avoid possible printing conflicts. When you’re finished, add

your new shapes to the Library palette for use in other publications.

 If you’re using an imported graphic as your template, make sure

you save it as a black-and-white bitmap before you import it into

PageMaker and create your customized text wrap—otherwise you

may not be able to hide it by applying the color “Paper” to it.

he text to the right was wrapped using

he pair of ovals above. We left the

raphic black so you could see it, but

hen you assign “Paper” or “None” to

, it will appear as an empty box in the

ibrary palette, so remember to give

 a descriptive name.
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